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Product Development, Review, and Management


This document provides information about the SCBC editorial and product development and management processes. It also provides guidance on technology platforms used to create and manage print and web-based content.
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1 Editorial Process
Note: This section is a draft—the formal editorial process is in development. 
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As early as possible, alert Information Services (IS) to upcoming editorial needs. Email OCCInfoServices@icf.com with as much of the following information as possible:

· Type of product (brief, memo, PowerPoint, etc.) 

· Approximate length (word count or number of slides)

· Whether the product will require Office of Child Care (OCC) approval after editorial review

· Approximate date it will be ready for editing and requested turnaround time (note any important client or external deadlines). Whenever possible, allow at least one week for short documents (under 2,000 words/20 slides) and at least two weeks for longer documents (over 2,000 words/20 slides).

· Level and type of assistance needed, as well as information about any nonstandard elements that may require extra time (for example, heavy formatting help, graphics, elaborate tables, or a large number of references)

· IS will confirm the request and reach out if further discussion is needed.

· Submit the document for editing when all input has been received and incorporated. For example, supervisor review and approval should be complete (if applicable), and tracked changes and comments not specifically directed to the editor should be removed. With the exception of client revisions, revisions after editing should be avoided to reduce the risk of typos and formatting complications.

· When the document is ready for editing, send it to OCCInfoServices@icf.com. Confirm the deadline and flag any notable changes to items listed under step 1. 

· The editor will confirm the timeline, edit the document, and adjust formatting as needed. 

· Word documents will be returned to authors with edits in track changes. Edits will not be tracked in PowerPoints. In both Word and PowerPoint, the editor may use comment bubbles to ask questions or flag significant edits that require author review and images that require will require alt text during 508 coding.

· Carefully review the edits and comments and accept tracked changes. 

· Authors are not expected to respond to the editor’s questions and comments, but should reach out to the editor for support if they have trouble addressing a comment. 

· See figure 1 for an illustration of how to accept all changes once they’ve been reviewed. Be cautious in rejecting changes that the editor has not flagged for review. If rejecting more than one or two such items, check with the editor. The editor can explain the revision and help ensure that rejecting it won’t create a grammatical mistake or inconsistencies elsewhere in the document.

1.1 Accept All Changes in a Document
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· If your document does not need OCC review, skip to step 9. 

· Authors are responsible for finalizing their documents; documents do not normally come back to the editor. Reach out to the editor if you encounter difficulty finalizing a document.

· If your document is going to OCC for approval, alert the editor as soon as possible if significant changes are expected. Documents do not normally come back to the editor, but a second editorial review may be needed if significant changes are made (consult the editor to determine whether this is the case). If the document needs to come back to the editor, please

· ensure that all changes in the OCC response are tracked;

· ensure that all required reviewers or approvers see the revised document before sending back to the editor; and

· update the file name to include the date in YYMMDD format (avoid using “final” in the file name until the document is completely final).

· If 508 coding is needed, review Preparing Documents for 508 Compliance before sending your final document to OCCInfoServices@icf.com.
2 Tips for Getting Your Product Ready for Editing

· Use an approved template. Documents not submitted in the template may be delayed. The templates, along with a tip sheet, are available on the workspace. It is easier to write your document in the template from the beginning than to paste it in at the end. Email OCCInfoServices@icf.com with questions about using the template.

· Spell out all acronyms and abbreviations the first time they are used.

· Ensure that references are used where needed; that direct quotations and excerpts are credited and clearly marked as such; and, if applicable, that all figures and images have complete source lines.

· Consult Protecting Integrity in Written Products for guidance.

· It’s better to include reference and source information as you write than to add it at the end. Maintaining this information on an ongoing basis reduces the risk that you will overlook something and commit inadvertent plagiarism. Contact the editors with questions about crediting sources.

· Double-check any hyperlinks in your document and make sure all your references are in American Psychological Association (APA) style. 

· Information about APA style is available through Purdue University’s Online Writing Lab: https://owl.english.purdue.edu/owl/resource/560/1/. 
· Reach out to the editors with questions about references. Authors should make a good-faith effort to provide complete APA-style citations, but don’t worry if they aren’t perfect—the editor will review them and decide how to handle those that don’t fit into a standard format.

· Ensure that you have received approval from your supervisor (if applicable) and incorporated feedback from others on your team as needed. 

· Remove all tracked changes and comments. The document should be as final as possible. Revisions after editing are best avoided to reduce the risk of typos and formatting complications.

3 Editorial Style Guide 

This document includes guidelines for Office of Child Care (OCC) project staff as they develop resources. These guidelines help promote consistency within and across OCC resources and enhance readability. Following them helps ensure that OCC resources are user-friendly and cohesive. The current style guide is applicable to all OCC projects held by ICF. 

Note: The style guide is undergoing peer review and will be posted to the workspace when finalized.

4 Protecting Integrity in Written Products
The following guidelines help ensure that Office of Child Care (OCC) project staff members avoid copyright infringement and plagiarism and cite information appropriately.
 The guidelines cover citation and permission requirements for summarized and quoted material as well as reproduction of full documents, excerpts, and images. This information is not legal advice. 

4.1 Our Values

It is essential that OCC project staff uphold the highest standards of integrity and quality at all times. We demonstrate these values through our written work by conducting due diligence for all material used, citing thoroughly and completely, and erring on the side of giving credit. We do not use resources if we cannot verify their ownership or our right to use them. Consistent application of these principles protects our reputation, shows that we respect the intellectual property rights of others, and demonstrates our commitment to quality work.
4.2 Summarizing and Quoting 
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The most common uses of others’ materials include quoting, paraphrasing, and summarizing their ideas and arguments.

Permission is not required for such uses of publicly available material. However, credit is always required. Citations must always be provided, even if the material used is paraphrased and is not a direct quotation.

Direct quotations should always be clearly designated as such through the use of quotation marks or block quotations. Staff should limit the number of quotations used and, generally, limit their length to a few sentences. 
Diligence in citing helps us (and OCC) look as professional as possible and adds validity to our materials.
4.3 Reproducing Documents and Images

4.3.1 Significant Excerpts and Entire Publications

Staff must take care to avoid copyright infringement when copying and distributing material (including significant excerpts that are beyond the scope of a standard quotation). 
Copying and distributing material without obtaining proper permission violates copyright law. Unless materials are in the public domain or include a copyright license or other statement specifically permitting free use, staff should obtain permission to do one of the following:

1. Contact the publisher to request (and, in most cases, purchase) copies to distribute. Staff can also ask for one reference copy to display, which may be free or be sold for a minimal cost.

2. Contact the publisher to receive permission to make photocopies (or a scanned PDF) of the entire resource or portions of the resource.
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Photos, Figures, and Other Images

Photos and images should be chosen from the OCC projects photo library rather than from outside sources. The images in the library have been purchased and are the property of OCC. The photo library and guidance for using it are available here: https://workspace.icfi.com/hscd/ees/occprojects/ApprovedPhotos/Forms/library.aspx. 

If you are unable to find an image that meets your needs and wish to use one from outside the collection, you are responsible for obtaining permission and providing an appropriate credit line. Because of permission and copyright issues, we are not able to use personal or family pictures in project materials. 

Avoid using graphs, charts, and other figures from outside publications unless they are highly relevant to the content of your publication or presentation. In many cases, graphs and charts are created using publicly available data. In such cases, it is best to go directly to the source to create your own graph or chart (always providing a citation for the data source). In addition to avoiding potential copyright issues, this approach enables you to create a customized figure that is more likely to be highly relevant to your product.

If, after considering the above, you wish to use a figure from an outside publication, you are responsible for obtaining permission and providing an appropriate credit line.

Note that attribution for photos, images, and figures is provided directly under the image rather than in references or footnotes (see Citations for format).
4.4 Obtaining Permission

Staff who decide to proceed with reproducing excerpts, entire documents, photos, figures, and other images are responsible for obtaining permission (unless the materials are in the public domain or include a copyright license or other statement specifically permitting free use).

· Contact the publisher via email and ask for written permission to copy, display, or distribute the desired resource in whole or part. 
· Contact information for permission requests can usually be find on the publisher’s website (sometimes buried in a section such as “publications” or “research”). If you are unable to locate the permissions contact, check the organization’s staff page for contact information for a publications director, editor, librarian, or someone in a similar role. Reach out to individual authors as a last resort. They are typically unable to grant permission on behalf of their organization, but may be able to facilitate your connection with the appropriate person.
· To facilitate your request, provide as much of the following information as possible: the resource’s full title, publication date, author names, ISBN, and URL.

· Be specific about how the resource will be used. For example, include page numbers for material that will be excerpted, page number and figure number for any image that will be used, number of copies you would like to distribute, and the purpose of the document you will be creating or the meeting you will be taking it to.

· [image: image49.png]BHS ©O-

EPRl -ovE | INSERT  DESGN  TRANSITIONS  ANIMATIONS sl
% Cu ayout - -
S = oel
E@ Copy £ Reset
Paste New "
' Format Painter |Gl "Eisection- | B I U S ax&-a-| A
Clipboard | Bty
1 J s | [
GHILOREN E2FAMLE g
TitleSide  Tiieand Content _Section Header

Two Content Title Only Content with
Caption
G
a
3 et Blank 1 Blank

e SR 43 Duplcate Selected Sides

[ Sides from Outline...



When you have obtained permission, save a copy of the email exchange on the workspace in Center Resources, folder “Permission Requests,” subfolder “Permission Granted.”

4.5 Public Domain

Permission is not needed to reproduce materials that are in the public domain. Staff are always required to provide attribution and give credit to the original author(s), regardless of public domain status.
Public domain is usually a matter of age; for example, materials published before a certain date are in the public domain. In addition, materials produced by the U.S. Federal Government are in the public domain.

· This article from the Stanford University library system provides a detailed explanation of public domain: 
Stim, R. (n.d.). The public domain. Retrieved July 21, 2016, from the Stanford University Libraries website: http://fairuse.stanford.edu/overview/public-domain/
· This table from Cornell University’s Copyright Information Center can be used as a checklist to help determine whether a work is in the public domain: 
Hirtle, P. B. (2016). Copyright term and the public domain in the United States. Retrieved July 21, 2016, from the Cornell University Copyright Information Center website: http://copyright.cornell.edu/resources/publicdomain.cfm
4.6 Citations
4.6.1 Citing Quotations and Paraphrased Ideas and Arguments

Quotations, paraphrased material, and other authors’ ideas and arguments should be cited in standard American Psychological Association (APA) format in a reference list, endnotes, or footnotes. Detailed guidance is available in the OCC projects style guide, and on the Purdue University Online Writing Lab website: https://owl.english.purdue.edu/owl/resource/560/1/. 
4.6.2 Citing Excerpts

It is important to ensure that excerpts are clearly distinguished from the rest of the text. They should be preceded by a statement such as the following

The following is an excerpt from Bridging the Gap: Exploring the Intersection between Workforce Development and Child Care (2015, p. 7), by Gina Adams, Shayne Spaulding, and Caroline Heller, Urban Institute (available at http://www.urban.org/research/publication/bridging-gap).

It should be clear where the excerpt begins and ends. The preferred method for distinguishing excerpts is indentation. If indentation is impractical, consider placing horizontal lines at the beginning and end of the excerpt. Avoid using italic text or making any significant formatting changes. In tricky situations, consult the editor for advice on the best format.
4.6.3 Citing Images

Citations for photos, images, and figures are provided directly under the image rather than in references or footnotes. In the OCC projects Word templates, use the style Table/Figure Note and Source. The following example demonstrates the format to use if the source is a publication; fill in as much of the information as is available or applicable. 

Source: Adams, G., Spaulding, S., & Heller, C. (2015). Bridging the gap: Exploring the intersection between workforce development and child care. Washington, DC: Urban Institute. Retrieved from http://www.urban.org/research/publication/bridging-gap
For a photo, source information may simply consist of the photographer’s name and website.

Source: Flickr user Epsen Gjelsten. Retrieved from https://www.flickr.com/photos/144036312@N05/28175411360/
5 [image: image50.png]Click to add title

Picture (U)

OfFiceof ChildCare
() Child Care State Systems Specialist Network



Preparing Documents for 508 Compliance Coding

5.1 What Is 508 Compliance?

Section 508, an amendment to the United States Workforce Rehabilitation Act of 1973, is a federal law mandating that all electronic and information technology developed, procured, maintained, or used by the Federal Government be accessible to people with disabilities. Under Section 508, agencies must give disabled employees and members of the public access to information that is comparable to the access available to others. 

In the scope of our work, any product, document, or resource we place on the Child Care Technical Assistance (CCTA) website must be made compliant so that assistive technology can read the document for those with visual impairments.
5.2 Preparing a Document for 508 Coding

Before submitting a document for 508 compliance, it must be in its final form—ensure that the document has been reviewed by all necessary parties and all revisions have been made. Submit the file in its original form (Word, PPT, or Excel). Those coding your document will convert it into a PDF.
Any edits, small or large, made to the document after it has been submitted for 508 compliance will delay the completion of 508 compliance coding. In most cases, changes made after beginning the 508 coding process will require recoding of the document in its entirety.
Provide detailed descriptions of all relevant images, graphs, and charts in a comment balloon in the body of the Word, PPT, or Excel file. If necessary, the coder will contact you to clarify this information prior to coding.
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If you have questions or need assistance with preparing documents for compliance, email OCCInfoServices@icf.com with the subject line “508.”
5.3 Submitting a Document for 508 Coding

Send documents for 508 compliance to OCCInfoServices@icf.com with the subject line “508.”
5.3.1 Formatting Checklist

To ensure that your document is coded accurately and in a timely manner, please ensure you have completed the following items before submission. You do not need to submit the completed checklist with your document; it is only for reference. However, the coder will scan the document against the checklist. If all items are not addressed, the document will be returned so you can address the incomplete items. This may cause a delay in the coding process.

	Item
	Checked and Resolved

	You have received all necessary approval, including approval from the Office of Child Care, if applicable
	

	The document has been copy edited and reviewed; final edits have been made 
	

	It was created in the proper template (either for the Child Care State Capacity Building Center [SCBC] or the National Center on Early Childhood Quality Assurance [ECQA Center])
	

	All hyperlinks are working correctly
	

	All tables and charts were created using the “Insert” function in Word
	

	For all tables in the document, the “Allow row to break across pages” option has been unchecked (this is within the table properties)
	

	For all tables in the document, the table header row is repeated at the top of each page
	

	For a document with a table of contents (TOC), the TOC was created using the TOC tool in Word rather than created manually 
	

	All lists (bulleted or numbered lists of items) were created by applying the proper styles in Word 
	

	References were created using the reference tool in Word 
	

	All indentations that were created with the space bar have been deleted
	

	All manual spaces before paragraphs have been deleted 
	

	The page numbers were created using the template style or by using the “Auto Insert Page Number” tool in Word 
	


5.4 More Information about Formatting for 508 Compliance

5.4.1 Describing Relevant Images, Graphs, and Charts

Descriptions will be used for alternate text, also known as, alt text. Alt text provides specific details about visual information for those with seeing impairments on the context, images may or may not require alt text (see the “Sample Graphic and Description” below for more information). A screen reader will read the provided alt text of the relevant image, graph, or chart for the listener. Note that all graphs and charts will require alt text to convey the data points. 

This means that when submitting documents for coding, you must provide detailed descriptions or data points of all graphs, charts, and images that convey important information. Enter descriptions in a comment balloon or send more lengthy descriptions along with the document in the body of an email or as a separate attachment. 

5.4.1.1 Relevant Images
Unless the image is integral to the document it does not require alt text. If the image contains information that is vital to the document, then it will require alt text. For example, a photograph of children and families inserted for visual appeal would not need a description. However, an image illustrating how two components of a system interact would need a description because the image represents important information. See the sample below for a sample of an image and its alt text.
5.4.1.2 Sample Graphic and Description
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5.5 Styles

Styles are the main elements of a template, and using template styles is essential for 508 coding. The styles set in the template have all fonts, colors, and spacing between lines preset so there is no need to create space using the space bar or enter button. Using the styles in your document reduces the amount of irregularities that can delay coding. Using the template ensures uniformity across all SCBC or ECQA Center documents, especially with regard to spacing. Do not change any of the preset style elements in any template. 
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To access template styles, go to the “Home” tab in Word. In this tab, the styles bar will be visible.
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To open the styles panel, click on the bottom left hand corner.
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5.6 Creating a List Using Styles

A bulleted list or bullet list is a list of items preceded with bullets instead of numbers or other objects. Below is an example of such a list. 

When making a list, follow styles in the template. Make sure you are using the correct list level or numbered list. 
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5.7 Creating a Table of Contents

It is essential to use the table of contents function in Word because when the document is converted into a PDF for 508 coding, the table of contents is automatically coded. Each item in the table of contents is automatically linked to its respective location in the document. Not using the table of contents function can delay coding.
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To create a table of contents, select the “References” tab.
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Next, select the “Table of Contents” tab and then select “Custom Table of Contents.”
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Make sure you select none for tab leader. Also select the levels you want to show (e.g., “2” for headings and subheadings).Generally you will want to show at minimum Section Head and Heading Level 1.

For more guidance: Table of Contents.

5.8 Resources

5.8.1 HHS.gov

For a more comprehensive explanation of 508 compliance and checklists visit HHS.gov.
· HHS 508 checklist for Microsoft Word. 

· HHS 508 checklist for Microsoft PowerPoint.
· HHS 508 checklist for PDF files.

6 Project Templates
All approved SCBC templates are available on the SCBC workspace, center resources, product development tools, at https://childcareta.acf.hhs.gov/admin/workspaces/292/workspace-resources. The following are useful tips for creating and formatting basic Word documents and PPT presentations in the SCBC templates. If you need support that goes beyond the guidance presented here, contact OCCInfoServices@icf.com. 

6.1 Word Template Document Tips

6.1.1 Tip 1: Build Your Document in the Template

You are encouraged to build your document using the SCBC templates. It is easier and more efficient to create the document in the template, rather than transferring the content into the template later in the process. If you need to transfer a document into the template, please see Tip 5 Paste Carefully for more information. Contact the Information Services team if you would like more in-depth assistance.

6.1.2 Tip 2: Save as a Word Document and Ensure Compatibility

There are a few things you should do right away in order to avoid formatting issues with your template document. Please follow the steps and screen shot below when you start a new document: 

· Locate the template on the SCBC SharePoint site here. We will update the template periodically, so using this link will ensure that you have the most current version.

· Open the template and select “Save As.”

· Title your document.

· Switch the document “Save as type” to Word Document.

· If you see a checkbox that says, “Maintain Compatibility with Previous Versions of Word,” ensure that you check it. If you do not see this box, your document is already compatible and no action is needed.

· Save your document to a location where you can work from it easily (e.g., your desktop, U drive, etc.).
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6.1.3 Tip 3: Use Styles 

Styles are the predefined formatting rules within the templates. The SCBC templates include styles for all levels of text (e.g., headers at different levels, body text, references, etc.), bulleted and numbered lists, and tables. Applying styles to your document’s content ensures that it is formatted consistently according to the rules in the template. Please follow the steps below to use styles in the template: 

· You will notice that the template includes sample text. You may use this sample text as reference as you apply styles to your document, or you can clear the sample text and work from a blank document. 
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Navigate to the top bar and open the styles pane in your document: 
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· The styles pane should open on the right side of your screen. You can change settings within the pane to make it easier to navigate: 
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· Every word of text, including tables and lists, needs to be in one of the predetermined styles. To apply a style to your text, select the appropriate style in the styles pane (e.g., Heading 1) and type your content. When you need to move to a new style, select a new style from the pane and type your content. Repeat as needed. 
· Note that even plain text within the body of the document needs to be in a style. Use the “Body Text1” style for this kind of text. 
· If you need to change the style of your content, highlight/select the text you wish to change and then select the style you wish to change it to. 
6.1.4 Tip 4: Update your Headers and Footers (twice!) 

The header and footer on the first page of the templates are different from the header and footer on subsequent pages. Make sure you edit the header and footer on the first page AND the second page. 
6.1.5 Tip 5: Paste Carefully 

As mentioned in Tip 1, it is much easier to build your document in the template than it is to transfer content into the template. However, if you do need to transfer content from one document into another, there are a few things you can do to make this easier: 

· Copy and paste in small sections.

· Use one of two methods to paste the content: A) paste as formatted text or B) use destination theme. To do this: 

· Copy the text you wish to transfer and then navigate to your template. 

· Click in the section where you wish to paste the text. 

· Use the paste dropdown in the top left corner to either: 

· Use destination theme

· Paste special and then select “formatted text”



· Once you paste your text into the document, highlight/select the text and apply the appropriate style from the style pane. Even if the text looks formatted, you still need to do this step to make sure you are using the right styles. 
· Note that if you are transferring content from another document that used styles, those old styles may appear in your new style pane. 
6.2 PowerPoint Template Tips
6.2.1 Tip 1: Build your PowerPoint in the Template

You are encouraged to build your PowerPoint using the SCBC templates. It is easier and more efficient to create the document in the template, rather than transferring the content into the template later in the process. If you need to transfer a slide into the template from another PowerPoint, please see Technology Guidance and Tips for PowerPoint for more information. Contact the Information Services team if you would like more in depth assistance.
6.2.2 Tip 2: Use Slide Layouts

Slide layouts are the predetermined formats for use when creating a new slide. The SCBC templates includes layouts for all levels of text (e.g., bulleted column list, multilevel bullets, tables, etc.). Using the layouts in your PowerPoint ensures that it is formatted consistently according to the rules in the template. Layout uses are defined by each layout title (e.g., cover slide, title and content, closing slide, etc.). Please follow the steps below to use layouts in the template: 

6.2.2.1 Creating a new slide

When creating a new slide use one of the approved layouts [image: image12.png]BHS OB-s
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6.2.2.2 Changing the layout of a slide in PowerPoint

If you would like to change the layout of a slide already in your PowerPoint, select the layout button to the right of the “new slide” button.
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6.2.3 Tip 3: Use Arial Font and Preferred Template Colors 

When creating your PowerPoint please make sure to use Arial font, and the approved set of SCBC colors for all graphics, shapes, tables, etc. Approved colors are set in the SCBC PowerPoint template and can be found in “Theme Colors.” Please do not change the font colors set in the layout (e.g. “Title” should be dark blue throughout the PowerPoint). 
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6.2.4 Tip 4: Save as a PowerPoint Presentation

· Locate the template on the SCBC SharePoint site here. We will update the template periodically, so using this link will ensure that you have the most current version.

· Open the template and select “Save As.”

· Title your PPT.

· Switch the document “Save as type” to PowerPoint Presentation.

· Save your PPT to a location where you can work from it easily (e.g., your desktop, U drive, etc.).

7 Picture Library
7.1 Guidance for Collection and Use of Photos and Other Images
The Office of Child Care (OCC) projects maintain a library of images that are available for use in print and web materials. It is accessible from the OCC Projects SharePoint site at https://workspace.icfi.com/hscd/ees/occprojects/ApprovedPhotos/Forms/library.aspx. This document provides guidance on the organization of the library, suitable and unsuitable images, browsing and keyword searches, and saving photos to a document.

Notes: 

· Any photo that contains “2016” in the file name was collected during the January 2016 picture library refresh. All other pictures are still available for use but may have been used in other publications over the past year.
· Picture library functionality will be supported by a future release of the workspace but will remain on the SharePoint site until that time.
7.2 Organization
The library is divided into seven categories:

1. Adults—pictures of adults only

2. Families and Teachers with Children—pictures of adults and children together

3. Infants and Children—pictures of children birth through school age

4. Items, Concepts, and Places—pictures meant to portray concepts, illustrations, and other images that don’t include humans

5. Logos—storage for National Center and other relevant logos

6. OCC Official Photos—photographs of OCC staff released for use in approved communications and products

7. State Specific Images—pictures of maps or flags of individual States and Territories

Also included in the library are photo releases for Administration for Children and Families (ACF), ICF, and WestEd. For more information about when these forms are applicable, contact the Information Services staff at OCCInfoServices@icf.com. 

7.3 Criteria for Images

Several general rules apply to images for inclusion in the photo library:

3. Photos should represent diversity in age, culture, gender, and family composition.
4. The collection as a whole should represent all proposed audience types (State-Level Professionals, Providers of Early Childhood Professional Services, Direct Child-Serving Practitioners, and Families and Communities).
5. Photos with white backgrounds should be kept to a minimum.

Prior to the most recent collection of images, the State Capacity Building Center (SCBC) Information Services staff consulted with the SCBC State Systems Specialists, the SCBC Infant/Toddler Specialists, and the National Center on Early Childhood Quality Assurance (ECQA) Center staff to define the types of images that are suitable for inclusion in federal products, as well as those that are not. A detailed list of each follows.
7.3.1 Suitable Images

· Adults making eye contact with infants or toddlers
· Adults observing infants and toddlers

· Adults talking with each other

· Children being held and cared for

· Children in different learning environments, playgrounds, etc.

· Children playing together

· Children with visible special needs

· Concepts, gears, management

· Emergency preparedness or response in child care

· Ethnically diverse children at play

· Health and safety in child care (babies sleeping on their backs, immunizations, etc.)

· Monitors, inspectors, home visitors

· Pacific Islanders, Alaska Natives, tribal, and other ethnic families and children

7.3.2 Unsuitable Images

· Babies in cribs with soft bedding, blankets, pillows, stuffed animals

· Children in front of screens (television, computer, mobile phone)

· Children posed for a camera

· Infants in restrictive devices such as bouncy seats, etc.

7.4 Searching for Images

There are two methods you can use to find appropriate pictures to meet your needs—browsing and searching.

7.4.1 Method 1: Browsing

If you are interested in looking at pictures that might be useful, you can browse the libraries to find a picture.

6. Go to the category that best fits your content by clicking on that folder.
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7. You are now in the picture library.
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8. You can scroll up and down, or click on the right arrow next to “1-50” to see additional pictures. Fifty pictures per page are displayed.
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It may be helpful to sort by the following columns:

· Approved- whether this picture has been explicitly approved by OCC

· Orientation- horizontal or vertical

· Background- color or white (this is important for pictures for use on the website—only ones with color backgrounds can be used)

7.4.2 Method 2: Searching by Keyword

If you have an idea of a specific type of picture you’re interested in finding, you can search using keywords. Appendix 1 of this guide includes a list of the keywords that are used in the library. 

1) Identify the keyword associated with what you’re trying to find. For example, when creating a PowerPoint presentation related to “teamwork” you can search for “teamwork” since it is on the list of keywords. You can also search for a combination of keywords such as “adult” and “teamwork.”

2) From anywhere in the picture library, type the keyword(s) into the search box on the top of the screen. Make sure the dropdown box says “This List: picture_library.” Enter your keyword. If you’re using more than one keyword, separate them with a space. You can then either press the enter key or click on the magnifying glass to search.
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3) This will bring up a list of pictures that have both keywords.
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7.4.3 How to Download, Copy, or Paste Images

To use the picture “adulthandstogether,” the most important thing to remember about the copy/paste method is what NOT to do. Do NOT copy/paste the small image that shows up either in the picture library listing or the search results.
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DO NOT right click these images and copy/paste. They are simply small previews of the pictures that are not of high enough quality to be used in printed or online materials. The pictures will be too small for the documents, and resizing will cause them to be blurry or pixelated. Instead, take the following steps.
7.4.3.1 Downloading and Inserting Pictures
For images in the library:

1) Click on the NAME field. This will open a large version of the picture.
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2) Once the picture opens, right click the picture and select “copy.” 
You can then paste the picture into your document. Alternatively, if you don’t want to copy/paste, you can right click and select “save picture as.” This will open a file and you can save the picture to your own computer and insert into a document.
7.5 Compressing Pictures
Frequently, the documents we create must be shared via email. Images can be very large and create problems with sending the files containing them as email attachments. To greatly decrease the size of the file, take the following steps to compress the pictures in your PPT presentation:


9. Click on any picture in the PPT file. 
10. Click on Picture Tools.

11. Click on Compress Pictures.

12. In Compression Options, unclick Apply only to this Picture.

13. In Target Output, click Email.

14. Click OK.

Taking these steps should decrease the overall size of the PPT file and allow for sending via email.

Note: Pictures can also be compressed in Word documents, however, this scenario is less common in our work. If you need assistance, contact Information Services.

7.6 Additional Guidance on Images

The images in the OCC projects picture library have been purchased and are the property of OCC. When possible, images should be chosen from this collection rather than from outside sources. If you are unable to find an image that meets your needs and wish to use one from outside the collection, please contact the editor for guidance on how to properly credit the image. Additionally, you may contact Information Services to assist with obtaining a specific image should the need arise. Due to permission and copyright issues, we are not able to use personal or family pictures in project materials.

8 Content Management System

The Child Care Technical Assistance Content Management System (CMS) is a component of the public facing CCTA website designed to assist the National Centers in managing their content and keeping the information on the public facing website up to date. It also serves as a repository of nonpublic resources that can be accessed by OCC staff and ECTTAS partners. All content is managed using a workflow process and corresponding user roles to control access to the content at various stages. The CMS protocol
9 Technology Guidance

9.1 Microsoft PowerPoint

The following guidance was created to provide assistance with some of the frequently used functions of Microsoft PowerPoint, as well as to provide resources for help and training. 

Please note that the SCBC and ECQA Center Templates exist as resources to make formatting easier and more straightforward. They can be found at https://workspace.icfi.com/hscd/ees/occprojects/TANetwork/Templates/Forms/AllItems.aspx and https://workspace.icfi.com/hscd/ees/occprojects/Quality/Templates/Forms/AllItems.aspx. Templates will also be available in Center Resources on each Center’s workspace.
Specific topics addressed in this section include the following:

9.2 How to Find Help

9.2.1 PowerPoint Help Function

To search for help, click on the question mark at the top right of your computer screen and type in specific key words. You may also press F1 at the top of your keyboard to access the Help Function.
9.2.2 Use Google to Find Help

Google searches can provide helpful links to how-to documents and tutorials. In order to target the most useful information, be very specific about what you are searching for.

[image: image25.png]Google  geteting asiide in Poveer Point




9.3 Specific Functions: How To…
9.3.1 Add a Slide

15. Click the slide located before your intended new slide.  

16. If you would like your new slide to have the same layout as the slide prior, you may simply click New Slide in the Slides section of the Home tab.

Tip: If you would like your new slide to have a different layout, click the arrow next to New Slide and select your desired layout from the choices.


9.3.2 Delete a Slide
17. Right click the slide you would like to delete, and then click Delete Slide.

18. To delete multiple sequential slides, click the first slide that you want to delete, press and hold the Shift Key while you click the last slide that you want to delete, right click any selected slide, and then click Delete Slide.

19. To select and delete multiple nonsequential slides, press and hold the Ctrl Key while you click each slide that you want to delete, right click any selected slide, and then click Delete Slide.

9.3.3 Copy and Paste a Slide

20. Select the slide you would like to copy, right click it, and select Copy.

21. To copy multiple sequential slides, click the first slide that you want to copy, press and hold the Shift Key while you click the last slide that you want to copy, right click any selected slide, and then click Copy.

22. To select and copy multiple nonsequential slides, press and hold the Ctrl Key while you click each slide that you want to copy, right click any selected slide, and then click Copy.

23. To paste the slide(s), click between the slides where you’d like the copied slide(s) to go, right click, and select Paste.


9.3.4 Copy Content to a New Template

1. Copy the slides you would like to transfer by following the directions above.

2. If you would like your slides to adopt the template of the new presentation, right click the slide (in the new presentation) that you would like your copied slides to follow.  

3. Under Paste Options click the first clipboard option, Use Destination Theme. 

4. After your copied slide appears in the new template, you may have to remove any headers or footers that overlap with the new template. 

9.4 Merging Two Presentations into One
24. Open the presentation into which you want to insert another presentation.

25. Click on the slide before the space where you would like the external slides to go.

26. Click on the New Slide button and select Reuse Slides…
27. Under the “Insert Slide from:” box, click on Browse then Browse File. Find the presentation you want to insert on your computer and click open.
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5. The slides will show up in a bar on the right of your screen. At the bottom of the bar, click on Keep Source Formatting so that the slides stay formatted the way they were meant to.
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6. To insert slides, click on them once. They will be added to the presentation.

9.5 Inserting Pictures, Audio, and Video into Slides 

9.5.1 Inserting Pictures from the Picture Library into a Slide

28. Find the picture you’d like to include in the Picture Library on the portal. Click the picture in the list to get to the individual picture record.

29. Right click on the picture and select Copy.
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30. Go to the slide where you’d like to put the picture.
31. Right click where you’d like the picture to go, and click Paste.

TIP: If you want to resize the picture, be sure to avoid warping by clicking and dragging diagonally. Don’t just make the image wider without making it taller, or vice versa.

9.5.2 Inserting audio or video into a slide
32. Click where you want the audio or video to go.

33. On the Insert tab, select Audio or Video and select the “on My PC” option from the dropdown menu.

34. Browse to where the audio or video is located on your computer and click Insert. 
NOTE: Audio and video files inserted this way are not compatible with Adobe Connect. 
9.6 Pecha Kucha (adding timing to slides)

Pecha Kucha is a presentation style that is image-focused and has crisp pacing. Each presentation is 20 slides long, with 20 seconds each. To create a Pecha Kucha presentation, you will need to turn on timing for the slides.

35. In the Transitions tab, under Advance Slide, check the box that says After, and enter the desired amount of time (for Pecha Kucha, 00:20.00)
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36. On the Slide Show tab, make sure the Use Timings box is checked

Tip: If you’re presenting your slideshow in Adobe Connect, the timings function does not work. In this case, you’ll need to have someone manually advance the slides for you.

9.7 Training and Tutorials 
· General PowerPoint Guidance

· PowerPoint 2013 Quick Start Guide
· PowerPoint 2013 Tutorials Video!
· Adding, Deleting, and Copying Slides

· Insert a New Slide
· Add, Rearrange, and Delete Slides
· Copy and Paste Slides 

· Inserting Audio and Video

· Inserting Video Video!
· Inserting Audio Video!
· Pecha Kucha

· Pecha Kucha FAQs
· Tips for a Pecha Kucha Presentation
· Rehearse Timings for a Slide Show Video!
10 Microsoft Word
The following guidance was created to provide assistance with some of the most frequently used functions of Microsoft Word, as well as to provide resources for help and training. Please note that the SCBC and ECQA templates exist as resources to make formatting easier and more straightforward. They can be found at https://workspace.icfi.com/hscd/ees/occprojects/SCBC/Templates/Forms/AllItems.aspx and https://workspace.icfi.com/hscd/ees/occprojects/Quality/Templates/Forms/AllItems.aspx, respectively, and will also be available in the Center Resources of each workspace. 

10.1 How to Find Help
10 Use the Word Help Function

Word Help offers extensive details about the many features and shortcuts available within the program. Click on the question mark at the top right of the screen and use general or specific search words depending on what you need to do (e.g., tables vs. inserting a row in a table). Click on the desired topic for more information.

10 Use Google to Find Help

Google searches can provide helpful links to how-to documents and tutorials. In order to target the most useful information, be very specific about what you are searching for. It may be necessary to browse several different articles to locate the specific information. If you do not find what you are looking for, try another search using different terminology. The articles you review might give you additional ideas about how to phrase your question.  
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10 Specific Functions: How To…
10 Format a Table

10 Add a Column or Row 

37. Right click in a cell to the left or right of where you want to add a column, OR right click in a cell above or below where you want to add a row.

38. On the shortcut menu, point to Insert and choose your desired command. Video How-To! (The column or row inserted will have the same properties as the column or row you clicked on (i.e., If you clicked on a merged row it will insert another merged row).

10.2.1.2 Delete a Column or Row

39. Position your cursor and select the column or row you want to delete by clicking to the left of the row OR the column’s top gridline.

40. Right click on the column or row, click delete cells, and select delete columns or delete rows.


10 Add Shading

41. Position your cursor and highlight the column, row, or cell you wish to shade.
42. Right click on the highlighted section and locate Borders and Shading.
43. Click on the Shading tab, select the color choice, and click OK. Make sure to choose whether to highlight the cell(s) or the entire table.
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Tip: If you want to shade a cell the same color as an existing cell but are unsure what color was used, highlight the already shaded cell, and follow the steps above. You will see that one of the colors has a dark border around it, indicating it is the selected color. If you do not see one with a border you can click on More Colors and then on the Custom tab. You can then copy the code for the exact color that was used. Repeat these same steps on the column you want to shade and enter the color code. Many of the approved ACF colors can be created by using the custom color tab. ACF approved colors can be found here.

Alternatively, you can shade a cell or cells by selecting the cells for shading and clicking the paint bucket icon on the Home tab. 
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10.2.1.4 Repeat Header Row Video How-To!
44. Select the heading row or rows. The selection must include the first row of the table.

45. Under the Layout Tab, click Repeat Header Rows. 

10.2.1.5 Allow Table to Break Across Pages Video How-To!
46. Click in the table.

47. Click the Layout tab.

48. Click Properties, and then click the Row tab.

49. Click the Allow row to break across pages check box. 

 Tip: if you do not want rows to break across pages, simply uncheck the “Allow row to break across pages” box.  However, you must be careful when you do not allow the rows to break across a page. If the text is too large to fit on one page, and the “allow row to break across page” is unchecked, any excess text will be hidden from view.  
10 Merge and Split Cells

How to merge (combine) cells:

50. Select the cells that you want to merge. When you select the cells, the Layout tab will appear on the toolbar.

51. When you are ready to merge (or combine) the cells, select the Merge Cells button located in the top toolbar.  
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10 How to split (break) cells

52. To split a cell in order to create multiple cells, select the cell(s) you want to split.  Once the cells are selected, the Layout tab will appear on the toolbar.

53. When you are ready to split the cells, select the Spilt Cells button located in the top toolbar. After clicking Split Cells button, a second box will appear where you can enter the number of rows and columns you want to create after splitting the cell(s).
10 Size and Distribute Rows and Columns Evenly

54. To use your mouse, rest the cursor on right side of the column (or bottom of the row) boundary you want to move until it becomes a resize cursor [image: image34.png]




, and then drag the boundary until the column is the width you want.

55. To change the width to a specific measurement, click a cell in the column that you want to resize. On the Layout tab, in the Cell Size group, click in the Table Column Width box, and then specify the options you want.

56. To make the columns in a table automatically fit the contents, click on your table. On the Layout tab, in the Cell Size group, click AutoFit, and then click AutoFit Contents.
Tip: To distribute rows and columns evenly do the following: Video How-To!
57. Select the whole table. Two new Table Tools tabs (Design and Layout) will appear in the Ribbon when the table is selected.

58. Select the Layout tab.

59. In the Cell Size group, you will see an icon for “Distribute Columns” below an icon for “Distribute Rows.” [image: image35.jpg]B HO S ¥ - New Microsoft Word Document [Compatibility Mode] - Word TABLE TOOLS
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10 Use the Format Painter Tool
You can use the Format Painter on the Home tab to apply text formatting and some basic graphics formatting, such as borders and fills.
60. Select the text or graphic that has the formatting that you want to copy.

61. NOTE:  If you want to copy text formatting, select a portion of a paragraph. If you want to copy text and paragraph formatting, select an entire paragraph

62. On the Home tab, in the Clipboard group, click Format Painter. Video How-To!
63. Select the text or graphic that has the formatting that you want to copy.

64. NOTE: If you want to copy text formatting, select a portion of a paragraph. If you want to copy text and paragraph formatting, select an entire paragraph, including the paragraph mark.

65. On the Home tab, in the Clipboard group, click Format Painter.
Tip: Double clicking on the Format Painter allows you to “paint” the format multiple times within the document.

10 Use the Paragraph Function: Line Spacing

66. To set the line spacing or the spacing before or after a paragraph or bullet, locate the line and paragraph spacing feature in the paragraph section under the Home tab, and set the desired spacing.

67. To change line spacing within a document or apply a change to the entire document, highlight the specific section OR the document in its entirety and follow the directions above. Video How-To!
68. Note: On some occasions line spacing may be erratic. This can often be corrected by ensuring that the check box next to the “Don’t add space between paragraphs of the same style” is not checked.

10 Add, Delete, or Change a Watermark

69. Locate the watermark feature in the page background section of the Page Layout tab (Design tab for Word 2013). 
70. Click on the arrow under Watermark and select the desired option. You will find popular watermarks to click on and apply to your document, as well as options to remove the watermark or customize your own specific background. Video How-To!
71. Users can also create a Custom Watermark (e.g., Do Not Distribute, etc.) by clicking Custom Watermark. 
Tip: When inserting a watermark, you can format the watermark horizontally or vertically by selecting the appropriate layout radio button when inserting a Custom Watermark.
10 Save a Word Document as a PDF

There are two ways to save a Word document as a PDF: 1) save as a PDF from within an open Word document; or 2) convert the Word document to a PDF.

Save from an open Word document:

72. Locate the Save feature by clicking on the File tab at the top left corner of the screen.

73. Click on Save.  Once you have named your document and chosen a location to save it, click on Save as Type, choose PDF from the dropdown box, and click OK. Video How-To!

Convert a Word document to a PDF:

74. Right click on the name of the document and choose Convert to Adobe PDF from the dropdown menu.

75. Click Save when the following menu appears. The document will automatically save and open as a PDF.


10 Save a PDF as Word Document
Users with Adobe Pro installed can create Word Documents from PDF if the PDF document was originally developed as Word document.
76. Select and open the PDF document you want to convert

77. Once this PDF is open within Adobe Pro, select File(Save As(Save As Other( Microsoft Word. Video How-To!
Tip: While this conversion works well on text, things like table formatting, images, smart art, etc. don't always translate well. Always make sure to carefully review the new word document for formatting issues.
10 Insert Objects or Pictures and Format Adjacent Text
78. To insert a picture, first ensure that you have the picture file saved on your computer.

79. Then, within Word, select Insert and then click Pictures.
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80. Navigate to the file location and select Insert.
10 Format Adjacent Text

81. When inserting a picture where additional text is to surround the picture, you can move the picture into place by right clicking the picture and selecting Size and Position.

82. A dialogue box will appear and you will want to select Text Wrapping.

83. Depending on where you want the picture in relation to the text, you will select the appropriate option, most often the option selected will be the “Tight” option.  Enhanced flexibility for picture placement can also be achieved by selecting the “Through” option. Video How-To!

10 Training and Tutorials

· General Word Guidance

Top Tips MS Word
Microsoft Office and Microsoft Word Basics

· Formatting Tables

Tables I: Get Acquainted with Tables 

Rows & Columns in Word 2010  

Editing Table Structure
· Using the Paragraph Function: Line Spacing

Adjust the Line Spacing Between Text or Paragraphs
Set Line Spacing in Word 2010
· Adding, Deleting, and Changing Watermarks 

Insert a Watermark or Change a Watermark


Set Watermark in Word 2010
· Saving a Document as PDF 

Save a Document as a PDF (for all Microsoft Office applications)

· Creating Templates

Save a Word Document as a Template
11 Workspace User Guide

The Workspace is a web-based tool that promotes online collaboration for the Office of Child Care (OCC) projects. It is available to both ICF and non-ICF partners and is located on the Child Care Technical Assistance website at https://childcareta.acf.hhs.gov/user.
Consider consulting IS before beginning work on your product. For large, complex, or challenging projects, an early conversation with the IS Coordinator and one of the editors is strongly recommended. For example, a conversation may be valuable in the following circumstances:


Multiple pieces required for the same deliverable


Unusual branding or template considerations


Interactivity needed (e.g., Survey Monkey or fillable PDF or Word document)


Large or complex volumes of data or information


Web posting needed


Writing for an audience other than the usual





Common Knowledge: Cite or Not?


Facts that are considered common knowledge do not need to be cited. The University of Pennsylvania defines common knowledge as follows:


Common knowledge is any information that the average, educated reader would accept as reliable without having to look it up. 


Determining whether something is common knowledge can be tricky, so when in doubt, cite! 


An in-depth discussion of common knowledge, including examples, is available in the University of Pennsylvania’s “Avoiding Plagiarism: What Is Common Knowledge?” (� HYPERLINK "http://www.upenn.edu/academicintegrity/ai_common%20knowledge.html" �http://www.upenn.edu/academicintegrity/ai_common%20knowledge.html�). 





Whole documents and lengthy excerpts that were originally created by others should be left in their original format. They should not be put into OCC project templates. 


Shorter excerpts may be included within OCC project documents, so long as they are clearly set off from the rest of the text and full attribution is provided.


Detailed guidance specifically for Child Care and Development Fund Plan excerpts is available in the OCC projects style guide.





Sample Permission Request


Dear Ms. Smith:


I am writing to request permission to reuse material from your publication, Bridging the Gap: Exploring the Intersection between Workforce Development and Child Care (May 2015), by Gina Adams, Shayne Spaulding, and Caroline Heller (� HYPERLINK "http://www.urban.org/research/publication/bridging-gap" �http://www.urban.org/research/publication/bridging-gap�). 


I am making this request on behalf of the [choose one: Child Care State Capacity Building Center, a service of the Office of Child Care, Administration for Children and Families, U.S. Department of Health and Human Services or National Center on Early Childhood Quality Assurance, Administration for Children and Families, U.S. Department of Health and Human Services].


We seek permission to reproduce table 2, State and Local Actors and Roles (p. 16). The table will be used in a PowerPoint presentation as part of a national webinar on cooperation between child care agencies and workforce development agencies. We anticipate around 50 attendees, including Child Care and Development Fund Administrators, staff from state-level child care agencies, Office of Child Care Regional Program Managers, and possibly other senior Office of Child Care staff. A link to the webinar recording will be made publicly available on the Office of Child Care website.


Please reply with permission and terms for this use.


Thank you, 


Jane Doe [Include full signature block.]





Additional Resources


The full Government Printing Office Style Manual is available at � HYPERLINK "https://www.gpo.gov/fdsys/pkg/GPO-STYLEMANUAL-2008" �https://www.gpo.gov/fdsys/pkg/GPO-STYLEMANUAL-2008�.


The following website provides a thorough overview of APA style, including references: � HYPERLINK "https://owl.english.purdue.edu/owl/resource/560/1/" �https://owl.english.purdue.edu/owl/resource/560/1/�.


The editors and other members of the Information Services team are available to answer questions and help find solutions. Contact us at � HYPERLINK "mailto:OCCInfoServices@icfi.com" �OCCInfoServices@icfi.com�. 





Before submitting a document for 508 compliance, it must be in its final form.


Any edits, small or large, made to the document after it has been submitted for 508 compliance will delay the completion of 508 compliance coding. In most cases, changes made after beginning the 508 coding process will require recoding of the document in its entirety.








Description of Image (Alt Text)


Six webs stemming from Relationship-Based Care: Cultural Responsiveness, Individualized Care, and Inclusion of Children with Special Needs, Small Group Size, Primary Care, and Continuity of Care.





The styles panel will correspond with the elements in the template. Use the template as a guide for which style to use.





If you have this compatibility checkbox, ensure that it is checked





Title your document





Save as Word document





In your top bar, click here to open the styles pane





Check the “Show Preview” box to display the formatted styles





Under “Select styles to show,” select “Recommended”� 


Under “Select how list is sorted,” you can alphabetize the styles in the styles pane to make them easier to find





Click options and this box will open





Click “Use Destination Theme”





OR click “Paste Special” and select “Formatted Text”





Click on arrow under “New Slide”





Select layout of choice from the dropdown menu





Select layout of choice from the dropdown menu





Click on “layout” to change the layout of a slide





Approved colors are located in the red box. Approved colors are white, black, and the two SCBC shades of blue








� Copyright infringement and plagiarism two different things. The following explanation is from Harvard University’s Office of the General Counsel:


Plagiarism is the misappropriation of another's work, passing it off as your own without indicating the source. It is possible to plagiarize a work without infringing the copyright—for example if you take another’s ideas without proper attribution, even though you do not copy the language, or you borrow from a work whose copyright has expired. Conversely, it is possible to infringe without plagiarizing. Properly citing the work you are copying does not avoid liability for infringement.


Harvard University Office of the General Counsel. (2016). Copyright and fair use: A guide for the Harvard community. Retrieved July 21, 2016, from � HYPERLINK "http://ogc.harvard.edu/pages/copyright-and-fair-use" �http://ogc.harvard.edu/pages/copyright-and-fair-use� 
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